Using Reports

Purdue University
IT Computing Services
Staff Computer Training
www.purdue.edu/itap/itcs/sct
Revised: March 1, 2003
# Table of Contents

ABOUT THIS TRAINING .................................................................................................................. 1

TRAINING OBJECTIVES .................................................................................................................. 1

  STANDARD CONVENTIONS FOR DOCUMENTATION .................................................................. 2
  KEYBOARD CONVENTIONS .......................................................................................................... 2
  MOUSE CONVENTIONS .................................................................................................................. 2

WHAT IS BRIQUERY? ...................................................................................................................... 3

BENEFITS OF BRIQUERY .............................................................................................................. 3

BRIQUERY SECTIONS (SECTION PANES) ...................................................................................... 3

BRIQUERY WINDOW FEATURES AND TOOLS ......................................................................... 4

  MENU BAR .................................................................................................................................. 4
  REQUEST LINE ........................................................................................................................... 4
  LIMIT LINE ................................................................................................................................. 4
  SORT LINE .................................................................................................................................. 5
  TOOLBARS .................................................................................................................................. 5
  CONTENTS PANE ........................................................................................................................ 7
  SECTION PANE ........................................................................................................................... 7
  SECTION TITLE BAR .................................................................................................................... 7
  CATALOG PANE .......................................................................................................................... 8
  STATUS BAR ............................................................................................................................... 8
  OUTLINER .................................................................................................................................... 9

NOTES ............................................................................................................................................ 10

USING THE REPORT SECTION ..................................................................................................... 11

  ➢ CREATING A REPORT .................................................................................................................. 12
  ➢ ADDING PAGE HEADERS AND FOOTERS ............................................................................... 14
  ➢ INSERTING PREDEFINED FIELDS ............................................................................................ 16
  ➢ ADDING REPORT HEADERS AND FOOTERS ......................................................................... 18
  ➢ ADDING EMPTY FIELDS ........................................................................................................... 18
  ➢ ADDING A GRAND TOTAL TO YOUR REPORT ....................................................................... 20
  ➢ ADDING TITLES TO FIELDS ...................................................................................................... 21
  ➢ ADDING A SUBTOTAL TO YOUR REPORT .............................................................................. 22
  ➢ CLASS EXERCISE ..................................................................................................................... 26
  ➢ COMBINING FIELDS .................................................................................................................... 28
  ➢ INSERTING AND REMOVING A PAGE BREAK ........................................................................ 30
  ➢ ADDING A GRAPHIC TO A REPORT ......................................................................................... 31
  ➢ ADDING A PIVOT TABLE TO A REPORT ............................................................................... 34
  ➢ MODIFYING THE PIVOT IN A REPORT .................................................................................... 36
  ➢ ADDING A CHART TO A REPORT ............................................................................................. 38
  ➢ RENAMING A REPORT SECTION .............................................................................................. 40
  ➢ CLASS EXERCISE ..................................................................................................................... 41

BRIQUERY RESOURCES .............................................................................................................. 45

  LIMIT TABLE ................................................................................................................................ 45
  STANDARD DATA FUNCTIONS .................................................................................................. 47
  DATA TYPES ............................................................................................................................... 49
About This Training

This BrioQuery training assists the learner in the use of the BrioQuery software. The training is intended for an intermediate or advanced user with prior experience in using this type of software and relational databases. Prior knowledge of the use of the Microsoft Windows 2000 operating system is required.

Training Objectives

This training will cover techniques used in the Report Section of BrioQuery and will focus on how to create and edit reports.

In this training you will learn:

- Basics of the BrioQuery Window
- How to Create Reports
- How to Add Page Headers and Footers and Report Headers and Footers
- How to Add Fields to Reports
- How to Graphics to Reports
- How to Add Charts to Reports
- How to Add Pivot Tables to Reports
- BrioQuery Tips
Standard Conventions for Documentation

- Actions are **bolded** and CAPITALIZED
- Special notes are *italicized*
- Button and menu names are set to 14 point font size and underlined.
- File names, paths or directories are printed in *Courier New*

Keyboard Conventions

- Names of keys that you press during hands-on exercises are in small capital letters, for example, **TAB** and **SHIFT**.
- A plus sign (+) between two key names means those keys must be pressed at the same time. For example, “Press ALT+TAB” means to hold down ALT while pressing TAB.
- A comma (,) between two or more key names means that you must press each of the keys consecutively, not together. For example, “Press ALT, T, X” means to press and release each key in sequence. “Press ALT+W, L” means to first press ALT and W together, release them, and then press L.

Mouse Conventions

- **Click** means to point to an object and then press and release the left mouse button. The word “click” is used for selecting command buttons, option buttons, and check boxes.
- **Drag** means hold down the mouse button while moving the mouse.
- **Double Click** means to rapidly press and release the mouse button twice.
- **Right Click** means to point to an object and then press and release the right mouse button. Clicking the right mouse button opens a shortcut menu that provides easy access to commands associated with the current action.
What is BrioQuery?

BrioQuery is a query and reporting tool for accessing databases from the Windows desktop. It allows the user to access data that is stored on database servers without understanding the complexity of query programming language. BrioQuery allows the user to create a query (or question) of the database. The information is retrieved in a spreadsheet-like format, and various reports can be created from that information. BrioQuery filters large quantities of data to select only what is desired. It also quickly formats data so results can be evaluated and understood.

Benefits of BrioQuery

- User-friendly Tool
- Predefined Data Models, Queries, and Reports stored in the repository
- User may create queries
- User may create reports that help answer management decisions with a reasonable response time
- User may focus on information without worrying about file structure
- User may save queries for later use or modifications

BrioQuery Sections (Section Pane)

- **Query** - Specifies the database fields that are to be retrieved and optional limit and sort conditions on the data values. Multiple queries can be created in a single *.bqy file.
- **DataModel** – A visual representation of an actual database.
- **Results** - Displays the data that matches the criteria in a query using a table format.
- **Pivot** - Constructs pivot reports summarizing query result data by various categories.
- **Report** - Formats reports that display and group the query results.
- **Table** - Displays a columnar representation of the data. The table section functions like the Results section in that Pivots and Charts can be based on a table’s dataset.
- **Chart** – Creates a 3-D graphic representation of data results.
- **Executive Information System (EIS)** – Allows users to build and deploy analytic applications. The EIS section is a pushbutton approach to querying a database. It is a document front-end that makes it easy for end-users to access information.
BrioQuery Window Features and Tools

There are a number of features and tools included in the BrioQuery screen display which are very useful. These include: the Standard Toolbar, the Request Line, Section Panes, and the Status Bar.

The following graphics show menus, toolbars and lines which appear when BrioQuery is launched. This includes the BrioQuery menu bar, the Standard Toolbar, and the Request Line.

**Menu Bar**
The menu bar shown is from the Query section and will be the menu bar shown at startup. Each section of BrioQuery has its own menu bar. While the File and Edit menus are standard across all sections, other menus will appear depending on which section is active.

**Request Line**
The Request Line is the area where named items (columns) are placed to return data from the database.

**Limit Line**
The Limit Line is the area where "limits" or criteria are placed on named items (columns) so that a smaller, more specific, subset of data is returned from the database. To view the Limit Line, CLICK on the Limits button in the Section Title Bar.
**Sort Line**
The Sort Line is the area where sort conditions on data fields are placed so that the data is returned in a specific order. To view the Sort Line, **CLICK** on the Sort button in the **Section Title Bar**.

**Toolbars**
The **Standard Toolbar** can be opened using the **View** menu. When a query is created or opened, this toolbar will be displayed. You can choose not to display this toolbar; however it is extremely useful. When you choose not to display the toolbar, it will not reappear when the tool is opened again.

In BrioQuery, typically there are at least three methods for performing most activities, a button on a Toolbar, a menu option, or a drag and drop method. If you choose not to use the Standard Toolbar, you have the option to use various menus to perform the same functions. Features from some of the menus are duplicated in the Standard Toolbar.
The functions available via the buttons in the Standard Toolbar are:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New Document</td>
</tr>
<tr>
<td></td>
<td>Open BrioQuery Document</td>
</tr>
<tr>
<td></td>
<td>Save BrioQuery Document</td>
</tr>
<tr>
<td></td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td>Print Preview</td>
</tr>
<tr>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td></td>
<td>Show Section/Catalog</td>
</tr>
<tr>
<td></td>
<td>Insert New Section</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
</tr>
<tr>
<td></td>
<td>Limit</td>
</tr>
<tr>
<td></td>
<td>Sort Ascending</td>
</tr>
<tr>
<td></td>
<td>Sort Descending</td>
</tr>
<tr>
<td></td>
<td>Apply Sum</td>
</tr>
<tr>
<td></td>
<td>Group Labels</td>
</tr>
<tr>
<td></td>
<td>Process</td>
</tr>
<tr>
<td></td>
<td>Connection Manager</td>
</tr>
<tr>
<td></td>
<td>Back</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
</tr>
<tr>
<td></td>
<td>EIS Home</td>
</tr>
<tr>
<td></td>
<td>Help</td>
</tr>
</tbody>
</table>

The **Formatting** toolbar is available in the **View** Menu. This toolbar will allow you to customize your reports to highlight important information and format the look.

The **Formatting** toolbar is a graphical representation of the functions supported by the various options in the **Format** menu. The **Format** menu is useful for making changes in all the sections: the **Results**, **Pivot**, **Table** sections, and the **Report** section.

The **Section** toolbar is only available in specific sections and provides commands to use in those sections.
Contents Pane
The Contents Pane is the lower right area of the window. The Contents Pane provides a view of the section you are using. It will show a Data Model, a Query, a Report, a Pivot or a Chart.

Section Pane
The Section Pane is located to the left of the Contents Pane. The Section Pane allows quick access to every section of the BrioQuery window: the Query section, the Results section, the Pivot section, the Chart section, and the Report section. There can be multiple Pivots, Charts and/or Reports, and therefore multiple sections. Pivot, Report and Chart do not automatically appear in the Section Pane. To create them, you must insert them using the Insert menu. To view the different sections, CLICK on each section and view it in the Contents Pane, or you can use the forward and back arrows in the Section Title bar.

Section Title Bar
The Section Title bar is a horizontal banner that runs across the top of each section. It displays the document sections that you are currently working with and includes buttons to navigate forward and back between sections. Clicking on a section will enable different buttons specific to that section. The Report Designer section title bar consists of the following single-click buttons: Sort, Expression, Groups and Table. Each of these buttons will toggle the respective area on and off.

- The Expression button toggles the Expression Builder bar, which allows you to build computed items and JavaScript expressions.
- The Groups button toggles the Group outliner. In this area, you can specify report categories.
- The Sort button toggles the Sort bar on/off, which allows you to rank data.
- The Table button toggles the Table Outliner on/off. This is the area where you can insert facts and dimensions into report bands.
**Catalog Pane**

The **Catalog Pane** is also located to the left of the **Contents Pane**. The **Catalog Pane** contains the data and objects that are used to build Pivot Reports, Charts, Tables and Reports. The **Catalog Pane** changes depending on the section you are working in. To use the **Catalog Pane**, drag an object from the **Catalog Pane** to the **Contents Pane** or to the **Outliner**.

**Status Bar**

At the very bottom of the BrioQuery window is the **Status Bar**. This feature gives you information about the number of rows returned by a query, the number of columns selected for the query, a graphic to show whether the database connection is active, and an information area which provides help information when you move the cursor to different areas of the window. The status bar will provide status statements during connection and processing.
Outliner

The Outliner in the Report section consists of the Report Group and the Table Dimensions and Facts. Placing a data item in the Report Group Outliner will define a group header or the highest level used to group data in a report.

In the Table Dimension pane, you can define secondary headings or labels that make up the body of the report. The Table Facts pane allows you to define measurable values or data that can be calculated. It also makes up the body of the report.
**DISCLAIMER:**

- All of the results in this manual are based on using the Training instance of the Employee Appointment data model.

- You will need to create a training OCE to access the training instance.

- If you have problems, contact the WAI Business Analyst at 49-49943.
Using the Report Section

The Report Section provides you the ability to create free form, presentation-quality reports. The Report layout tools simplify how you produce a report. The drag and drop interface enables you to easily add graphics and predefined fields to band-style reports; as well as data from multiple data sources like computed fields, charts and pivots. All of the exercises in this manual will be done using a Training datamodel, with the host dssqa. For detailed instructions on creating a training OCE, see the Open Catalog Extensions section in the Brio Query 6 Training Guide.

<table>
<thead>
<tr>
<th>Report Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Catalog Pane</td>
<td>The area on the left, below the Section Catalog, is the Report Catalog Pane. You drag items from this source area on the left into the Content Pane on the right to build the values portion of the report.</td>
</tr>
<tr>
<td>Contents Pane</td>
<td>In the Report section, the Contents pane is the area containing the report page.</td>
</tr>
<tr>
<td>Report Page</td>
<td>The report page structure is divided into group headers and body areas.</td>
</tr>
<tr>
<td>Report Body</td>
<td>Each report has a body, which holds a table of data. Tables are created with dimension columns and factual columns. Typically dimension columns hold textual content and factual columns hold numeric content. Several tables can be introduced into each band, and each table can originate from the same or different result sets in the document.</td>
</tr>
<tr>
<td>Report Group Headers</td>
<td>The group header categorizes data into repeating collections of records in a header band.</td>
</tr>
<tr>
<td>Report Header/Footer</td>
<td>Report headers and footers are treated as normal report areas allowing full customization of the contents, including the introduction of other report elements (Pivots, Charts), text labels and computed fields. Typically, the Report headers and footers are summarizing bands of information. The Report header prints on the very first page of the report only. The Report footer prints only on the very last page of the report.</td>
</tr>
<tr>
<td>Report Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Page Header/Footer</td>
<td>Page headers and footers are treated as normal report areas allowing full customization of the contents, including the introduction of other report elements (Pivots, Charts), text labels and computed fields. Typically, the page header and footer allow you to specify data that you may want to repeat on every page, such as the page number.</td>
</tr>
<tr>
<td>Report Outliner</td>
<td>The Report Outliner enables you to plot, view and manipulate dimensions and facts in your report.</td>
</tr>
<tr>
<td>Expression Bar</td>
<td>The Expression bar is a quick access line for building computed expressions. In addition to the pre-built functions that can be applied to computable fields, JavaScript expressions may be written to derive more advanced calculations.</td>
</tr>
<tr>
<td>Layout Aids</td>
<td>The visual construction of reports has several aids to facilitate layout. The aids include: page layout mode, report setup dialog, headers and footers, design tools, graphic components and formatting tools.</td>
</tr>
</tbody>
</table>

➢ Creating a Report

Once you process your query, you can create a report.

**TO CREATE A REPORT:**

1. OPEN the file, report1.bqy, and log on, if necessary.


3. DRAG “Campus Name” from the Catalog Pane to the Report Group1 section in the Outliner.

4. DRAG “Dept” and “Department Title” from the Catalog Pane to the Report Group2 section in the Outliner.

5. DRAG “Name Last” and “Name First” from the Catalog Pane to the Table Dimensions section in the Outliner.

6. DRAG “Fte” and “Full Time Annual Rate” from the Catalog Pane to the Table Facts section in the Outliner.

7. RESIZE the “Department Title” field, if necessary, to make the entire Department Title viewable.
The report should look like this:

![Image of report]

Note: To remove an existing total from a column, **RIGHT CLICK** on the column and **SELECT Show Column Total**. If the column total is not showing, this feature will make it appear.
Adding Page Headers and Footers

The page header and footer allow you to specify data that you may want to repeat on every page, such as the page number.

**To add a Page Header or Page Footer:**

1. To view the sections of the report, **SELECT** Section Boundaries from the **Report** menu.

2. **SELECT** Headers and Footers from the **Report** menu, and then **SELECT** **Show Both** under **Page Footer**. *This will automatically insert a Page number in both the Page Header and the Page Footer sections.* (You also have the option of selecting just a **Page Header**, or just a **Page Footer**.)

3. **SELECT** the **Page** field in the **Page Header** area on the report.

4. **CLICK** in the **Expression bar** and **DELETE** all the text (or the entire expression). If the **Expression bar** is not showing, **CLICK** on the **Expression** button to display it.

5. **TYPE** your **Page Header** between quotation marks in the **Expression bar**. **TYPE** in “Departmental Information by Campus”. *You must use the quotation marks for the Page Header to appear.*

6. **PRESS** the **ENTER** key. *The Page Header will appear.*
7. **CHANGE** the font size to 14 and **BOLD** the header.

8. **RESIZE** the field to make the entire **Page Header** viewable, if necessary.

---

**Note:** To format column titles, **RIGHT CLICK** on the column title and **SELECT Font**. In the **Properties** dialog box you can change the font, font size and font style. You can also align the column title using the shortcut menu. Formatting of column titles can also be done using the **Formatting** toolbar.
# Inserting Predefined Fields

You can add predefined fields to your report. The table below lists the predefined fields available in the Report Section. These fields can be dragged and dropped anywhere within the report page, body, group header, report header/footer and page header/footer.

<table>
<thead>
<tr>
<th>Predefined Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Limit</td>
<td>Inserts a selected query limit.</td>
</tr>
<tr>
<td>Result Limit</td>
<td>Inserts a selected result limit.</td>
</tr>
<tr>
<td>Query SQL</td>
<td>Inserts the last SQL statement sent to the database when the Process button is used.</td>
</tr>
<tr>
<td>Page Number</td>
<td>Inserts a page number.</td>
</tr>
<tr>
<td>Number of Pages</td>
<td>Inserts a total number of pages.</td>
</tr>
<tr>
<td>Page X of Y</td>
<td>Inserts current page of total pages.</td>
</tr>
<tr>
<td>Last Saved</td>
<td>Inserts the date on which the report was last saved in MM/DD/YY format.</td>
</tr>
<tr>
<td>Last Printed</td>
<td>Inserts the date on which the report was last printed in MM/DD/YY format.</td>
</tr>
<tr>
<td>Date</td>
<td>Inserts the current date in MM/DD/YY format. The Date field reflects the current date, meaning the date when the document is opened, and it will change every day that you open the document.</td>
</tr>
<tr>
<td>Time</td>
<td>Inserts current time in HH:MM format.</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>Inserts and stamps date and time in MM/DD/YY and HH:MM format.</td>
</tr>
<tr>
<td>Date Now</td>
<td>Inserts the current date in MM/DD/YY format. “Date Now” represents the date when a report was first created and it will never change.</td>
</tr>
<tr>
<td>Time Now</td>
<td>Inserts the current time in HH:MM:SS format.</td>
</tr>
<tr>
<td>Date &amp; Time Now</td>
<td>Inserts the current date and time in MM/DD/YY and HH:MM format.</td>
</tr>
<tr>
<td>File Name</td>
<td>Inserts the BrioQuery document (.bqy) name.</td>
</tr>
<tr>
<td>Path Name</td>
<td>Inserts the full path name of the document.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Inserts the report name.</td>
</tr>
</tbody>
</table>
TO ADD A PREDEFINED FIELD TO YOUR REPORT:

1. **SELECT** the **Report** menu.

2. **SELECT** **Insert Predefined Field**, and **SELECT** the **Date and Time** field.

3. **CLICK** in the **Page Footer** area to insert the Date and Time field. *The field will appear in the Page Footer area and print on all pages of the report.*

4. **MOVE** the predefined field to the right margin within the **Page Footer** by **CLICKING** and **DRAGGING** the field.

5. **SELECT** the **Date and Time** field and **CLICK** the **Justify Right** button on the **Formatting** toolbar to **RIGHT ALIGN** the field.

*The Page Footer in the report should look like this:*
Adding Report Headers and Footers

The Report Header and Footer will print once at the beginning of the report and once at the end of the report. This differs from the page header and footer which will display and print on every page.

**TO ADD A REPORT HEADER OR FOOTER:**

1. **SELECT** Headers and Footers from the Report menu.

2. **SELECT** Show Both under Report Footer. (You also have the option of selecting only a Report Header or only a Report Footer).

Adding Empty Fields

You can insert an empty field into your report. This allows you to customize the field and type in your own titles or labels.

**TO ADD A FIELD TO A REPORT:**

1. **SELECT** the Report menu.

2. **SELECT** Insert Field.

3. **CLICK** in the Report Header area to insert the field. A field will appear titled “EmptyField”.

4. **CLICK** on the “EmptyField” field.

5. In the Expression bar, **SELECT** the word “EmptyField” and **TYPE** the title “Departmental FTE by Campus”. *Be sure to type the title between the quotation marks.*

6. **PRESS** the Enter key.

7. **DRAG** the field to the center of the Report Header.
8. **CHANGE** the font size to 14 and **BOLD** the title.

9. **RESIZE** the field to make the entire **Report Header** viewable, if necessary.

*The report should look like this:*

![Report Example]

---

**Note:** You can also select Fields from the Fields Folder in the Catalog Pane. Click the plus sign to expand the Field Folder.
Adding a Grand Total to your Report

The Grand total will print on the last page of the report.

TO ADD A GRAND TOTAL TO A REPORT:

1. ADD a Report Footer to your report, if necessary (see instructions above).

2. CLICK to SELECT the Report Footer.

3. DRAG the field you want to sum, i.e. Fte, from the Catalog Pane and DROP it into the Report Footer.

4. CHANGE the font size to 14 and BOLD the field.

5. DRAG the Fte field in the Report Footer underneath the Fte field above it to line it up.
Adding Titles to Fields

You can add titles to existing fields in each section.

TO ADD A TITLE TO A FIELD:

1. **CLICK** on the Fte field in the Report Footer, if necessary.

2. In the Expression bar, place your cursor before the string of text.

3. **TYPE** “Total FTE: ” + **Format**(

4. **CLICK** at the end of text string and **TYPE**: , "##.##"). *This will format the number with two decimal places. The total string should read:*

   "Total FTE: " + Format(Tables("Results").Columns("Fte").Sum(currBreak),"##.##")

5. **PRESS** the Enter key.

6. **RESIZE** the field if necessary to make all the text viewable.
Adding a Subtotal to your Report

You can create subtotals within the report. The subtotals will print after each section that is subtotaled.

TO ADD A SUBTOTAL TO A REPORT:

1. **RIGHT CLICK** on the Campus Name field in the Report Group1 (Results) section of the Outliner and **SELECT Footer**.

![Image of Outliner and report group footer](image)

2. **SCROLL** within the report until you see Report Group1 Footer: (Results) Campus Name.

3. **DRAG** the field you want to sum, i.e. Fte, from the Catalog Pane and **DROP** it into the Report Group1 Footer: (Results) Campus Name.
4. Now add a title to the subtotal field. **CLICK** on the *Fte* field in the Report Group1 Footer: (Results) Campus Name.

5. In the **Expression** bar, place your cursor before the string of text.

6. **TYPE** “Subtotal for ” +

7. **PRESS** the *Enter* key.

8. **SCROLL** to the area of the report that contains the Campus Name field and **CLICK** on this field.

9. In the **Expression** bar, **SELECT** the entire string of text.

10. **SELECT** the Edit menu and **SELECT** Copy.

11. **CLICK** the *Fte* field in the Report Group1 Footer: (Results) Campus Name.

12. **CLICK** in the **Expression** bar, and place your cursor after the plus sign.
13. **SELECT** the **Edit** menu and **SELECT** **Paste**.

14. **PLACE** your cursor after the (“Campus_Name”) and **INSERT** "": "+

15. **The total string should read:**

"Subtotal for " + currBreak.Value("Campus_Name") + ": "+
+Tables("Results").Columns("Fte").Sum(currBreak)

16. **PRESS** the **Enter** key.

17. **CHANGE** the font size to 14 and **BOLD** the field.

18. **RESIZE** the field if necessary to make all the text viewable.

*The subtotal in the report should look like this:*

![Departmental Information by Campus](image)

19. **CLOSE** the query.
Note: In addition to copying and pasting fields to the Expression bar, you can also click on a field in the Catalog Pane and drag it to the Expression bar.
Class Exercise

Create a report.

REPORT

The report should contain the employees’ names, department titles and head count dept for the following department numbers: 1284, 1285, and 1288. Total the Head Count Department by department number and create a grand total for all departments.

1. OPEN the file, reportexer.bqy.
2. INSERT a report.
3. ADD “Dept” and “Department Title” to the Report Group1 section in the Outliner.
4. ADD “Name Last” and “Name First” to the Table Dimensions section in the Outliner.
5. ADD “Head Count Dept” to the Table Facts section in the Outliner.
6. RESIZE the “Department Title” field, if necessary.
7. CREATE a “Grand Total” for all departments by ADDING “Head Count Dept” to the Report Footer. (Hint: You have to add a Report Footer to your report first.)
8. ADD the title, “Grand Total” next to the “Head Count Dept” grand total field. (Hint: Use the Expression bar.)
   "Grand Total: " + Tables("Results").Columns("Head_Count_Dept").Sum(currBreak)
9. CHANGE the font size to 14 and BOLD the “Grand Total” Title and field.
10. RESIZE the field to make all the text viewable.
11. ADD a Page Header titled “Head Count by Department”. (Hint: You have to add a Page Header to your report first.)
12. CHANGE the font size to 14 and BOLD the title.
13. RESIZE the title, if necessary.
14. ADD a Page Footer that contains the “page number” and DRAG it to the left margin. Left justify the “page number” within the field, if necessary.
15. Also in the Page Footer, ADD the predefined field, “Date and Time”, and DRAG it to the right margin. Then right justify it within the field. (Hint: Use the Justify Right button on the formatting toolbar.)
The report should look like this.

16. CLOSE the query.
Combining Fields

You can combine existing fields to make one field.

TO COMBINE FIELDS:

1. OPEN the file, report2.bqy, and log on, if necessary.

2. CLICK the Report section, if necessary.

3. SELECT Section Boundaries from the Report menu.

4. CLICK on the Dept Title field in the Report Group2 Header.

5. In the Expression bar, SELECT the entire string of text.

6. SELECT the Edit menu and SELECT Copy.

7. CLICK the Dept field in the Report Group2 Header.

8. CLICK in the Expression bar, and place your cursor after the string of text.

9. TYPE " - " +

10. SELECT the Edit menu and SELECT Paste.

11. PRESS the Enter key.

    The total string should read:

    currBreak.Value("Dept") + " - " + currBreak.Value("Dept_Title")

12. RESIZE the field if necessary to make all the text viewable.

13. Now CLICK on the Dept Title field again (in the Report Group2 Header) and DELETE it from the Contents Pane (Hint: Do not delete it from the Outliner).
The report should look like this:

Note: If the field has been resized and you are still not able to view all the text, **RIGHT CLICK** on the field and **SELECT** Properties. **CLICK** the **Alignment** tab and **SELECT** the **Wrap text** checkbox under **Text Control**.
Inserting and Removing a Page Break

You may want to add page breaks to your report, so that each Department’s information prints on a separate page. You can insert a page break before or after a report group label.

TO INSERT A PAGE BREAK:

1. SELECT the area of the report where you want to insert the page break. SELECT Campus Name in the Report Group 1 Header section.

2. From the Insert menu, SELECT Page Break Before. (You can also select Page Break After.)

TO REMOVE A PAGE BREAK:

1. SELECT the area of the report associated with the page break, Campus Name.

2. From the Insert menu, SELECT Page Break Before (or Page Break After) to DESELECT the option that is checked.
Adding a Graphic to a Report

You can enhance a report by adding a graphic. BrioQuery has predefined graphic objects such as lines, rectangles and ovals which appear in the Graphics folder in the Catalog Pane of the Report Section. You can also add pictures to your reports. In order to add an image to a report, it must be a bitmap image and have a .bmp extension. The table below describes each of the graphic objects.

<table>
<thead>
<tr>
<th>Graphic Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Creates a line that you can rotate.</td>
</tr>
<tr>
<td>Hz Line</td>
<td>Creates a horizontal line.</td>
</tr>
<tr>
<td>Vt Line</td>
<td>Creates a vertical line.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Creates a rectangle.</td>
</tr>
<tr>
<td>Round Rectangle</td>
<td>Creates a rectangle with rounded corners.</td>
</tr>
<tr>
<td>Oval</td>
<td>Creates an oval.</td>
</tr>
<tr>
<td>Text Label</td>
<td>Creates a text label that you can use as a caption.</td>
</tr>
<tr>
<td>Picture</td>
<td>Allows the insertion of a bitmap image. Images must have a .BMP extension.</td>
</tr>
</tbody>
</table>

**To add a graphic object to a report:**

1. **DOUBLE CLICK** on the **Graphics** folder (or **CLICK** on the + sign) in the **Catalog Pane** to open it.

2. **CLICK** the graphic object you want to insert into the **Report**. **CLICK Hz Line**.
3. **DRAG** and **DROP** the graphic object, **Hz Line** into the **Page Header** under the text “Departmental Information by Campus”.

4. **RESIZE** the line so it’s long enough to underline the title, “Departmental Information by Campus”.

5. **RIGHT CLICK** on the line and **SELECT Properties**.

6. **CHANGE** the **Width** to “4 pt” and **CLICK OK**.

*The line in the report should look like this:*
**TO ADD A PICTURE TO A REPORT:**

1. From the **Report** menu, **SELECT** Picture.

2. **CLICK** the **Page Header** section of the **Report**. The **Select Image** dialog box appears.

3. From the Student folder, **SELECT** the image, *ItaP banner.bmp* and **CLICK** the **Open** button.

4. **RESIZE** the image in the **Page Header** so the whole image appears.

5. **DRAG** the image to **ALIGN** it to the right margin in the **Page Header**.

*The final report should look like this:*

![Report Image](image.png)

6. **CLOSE** the query.

**Note:** *If you add an image to a report, it must be a bitmap image and have a .bmp extension. When resizing an image, use the corner selection handles to re-size it proportionally.*
Adding a Pivot Table to a Report

You can enhance your reports by adding Charts and Pivots to them. Charts and Pivots are either static objects or dynamic objects depending on the relationship of the data in the report to the data in the Chart or Pivot section. If a relationship exists, then the Chart or Pivot is considered a "Smart Report."

TO ADD A PIVOT TABLE TO A REPORT:

1. OPEN Years of Service.bqy, and log on, if necessary.
   A pivot and chart have already been created. The borders have been removed from the pivot table.

2. From the Insert menu, SELECT New Report.

3. DRAG “Dept” and “Dept Title” from the Catalog Pane to the Report Group1 section of the Outliner.

4. RESIZE the “Dept Title” field so all the text is viewable.

5. From the Report menu, SELECT Section Boundaries.

6. SELECT the Body of the report. This is the area of the report where we will insert the Pivot.

7. CLICK the Table within the Body of the report and PRESS the DELETE key on the keyboard.

8. CLICK on the Pivot object in the Catalog Pane and DRAG it into the Body section of the Report.
9. **RESIZE** the pivot, if necessary.

The report should look like this:

![Pivot table example]

**Note:** In the above example, the borders have been removed from the Pivot table. To remove the borders from a Pivot, select the Pivot section in the Section Pane, **SELECT** the entire Pivot (CTRL+A). From the Format menu, **CLICK Borders** and **CLICK None**.
Modifying the Pivot in a Report

Once you have placed a Pivot in the Report section, modifying the Pivot section will automatically modify the Pivot area in the report.

To modify the Pivot:

1. **SELECT** the Pivot Section, if necessary.

2. **CLICK** the tab at the bottom of the “Dept” column to **SELECT** the entire column.

3. **CLICK** the Text Color button on the Formatting toolbar and **CLICK** Transparent. *The department numbers will be hidden.*

4. **CLICK** on the label, “Dept”. **CLICK** the Text Color button on the Formatting toolbar and **CLICK** Transparent. *The label will be hidden.*

5. **CLICK** on the Report Section. Notice that the Pivot in the Body of the report has been automatically updated and the department number and label no
longer appear.

The report should look like this:
Adding a Chart to a Report

You can add a chart to a report. The information depicted in the chart depends on the Report area selected. For example, if a chart is placed in the Report Header section, the chart will depict information for the entire report. However, if the chart is placed in a Report Group section, such as “Department Title”, it will depict information for just that department.

TO ADD A CHART TO A REPORT:

1. **ADD** a Report Header to the report. From the Report menu, SELECT Headers and Footers, and then SELECT Report Header.

2. **ENLARGE** the Report Header before adding the chart.

3. **CLICK** on the Chart in the Catalog Pane. See below.

4. **DRAG** the Chart to the Report Header.

5. **RESIZE** the chart, if necessary.
The report should look like this:
Renaming a Report Section

You can rename the Report Section to more clearly identify your reports.

TO RENAME A REPORT SECTION:

1. **DOUBLE CLICK** on Report in the Section Pane.

2. **TYPE** “Years of Svc” in the **Section Label** dialog box. **You do not need the quotation marks.**

   ![Section Label Dialog](image)

3. **CLICK OK.**

   *The final Report section should look like this:*

   ![Report Section](image)

4. **CLOSE** the query.
Class Exercise

Create two reports.

REPORT 1

The first report contains the employees’ names, department titles and head count dept for the following department numbers: 1284, 1285, and 1288. The Head Count Department has been totaled by department number and a grand total for all departments has been created. Add a chart to the report that includes the above information.

1. OPEN the file, reportexer1.bqy.
2. INSERT a new chart.
3. ADD “Dept Title” to the X-Categories section in the Outliner.
4. ADD “Head Count Dept” to the Y-Facts section in the Outliner.
5. ENLARGE the chart, if necessary.
6. MOVE the Legend to the bottom right corner of the chart.
7. SELECT the Report section.
8. SELECT Section Boundaries from the Report menu.
9. RESIZE the Report Footer of the Report to make it larger.
10. DRAG the Chart from the Catalog Pane to the Report Footer section of the Report.
11. RESIZE the Chart to make it all viewable.
12. RENAME the Report section to “Head Count by Dept”.

The bottom of your final report should look like this:
**REPORT 2**

The second report should contain the employees’ names, department titles and full time annual rates. First, create a pivot report with this information and add it to the report. Be sure to change the background and the borders of the pivot to white before adding it to the report.

1. The file, reportexer1.bqy should already be open.
2. **INSERT** a new pivot.
3. **ADD** “Name Last” and “Name First” to the Side Labels section in the Outliner.
4. **ADD** “Full Time Annual Rate” to the Facts section in the Outliner.
5. **RESIZE** the “Full Time Annual Rate” column, if necessary.
6. **ADD** Corner labels to the Pivot. (Hint: Use the Format menu or Right Click and Select Both.)
7. **SELECT** the entire Pivot report (Hint: CTRL+A), and **CHANGE** the background color of the Pivot to white.
8. **SELECT** the entire Pivot report, if necessary, and **REMOVE** the borders. (Hint: Select Borders from the Format menu and select None.)
9. **RIGHT JUSTIFY** the “Full Time Annual Rate” column heading.
10. **INSERT** a new report.
11. **DELETE** the Table in the Report.
12. **INSERT** the Pivot into the Body section of the Report. (Hint: Select Section Boundaries from the Report menu to see the sections of the report.)
13. **ADD** the “Dept Title” field to the Report Group1 section in the Outliner.
14. **RESIZE** the “Dept Title” field to make the entire field viewable.
15. **ADD** a Page Header titled “ Employees’ Full Time Annual Rates”. **CHANGE** the font size to 14 and **BOLD** the title.
16. **RESIZE** the title if necessary.
17. **RENAME** the Report section to “Full Time Annual Rate”.
The final report should look like this:

17. CLOSE the query.
## Limit Table

<table>
<thead>
<tr>
<th>Limit Type</th>
<th>Operation Performed to Select Data</th>
<th>Data on which this comparison is valid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal =</td>
<td>Only data where the requested item(s) is equal to the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Not Equal &lt;&gt;</td>
<td>Only data where the requested item(s) is NOT equal to the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Less Than &lt;</td>
<td>Only data where the requested item(s) is less than the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Less or Equal &lt;=</td>
<td>Only data where the requested item(s) is less than or equal to the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Greater Than &gt;</td>
<td>Only data where the requested item(s) is greater than the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Greater or Equal &gt;=</td>
<td>Only data where the requested item(s) is greater than or equal to the specified value(s) will be retrieved.</td>
<td>text, numbers, dates</td>
</tr>
<tr>
<td>Begins With</td>
<td>Only data where the requested item(s) begin with the specified value(s) will be retrieved.</td>
<td>text</td>
</tr>
<tr>
<td>Contains</td>
<td>Only data where the specified value(s) is somewhere in the requested item(s) will be retrieved.</td>
<td>text</td>
</tr>
<tr>
<td>Ends width</td>
<td>Only data where the requested item(s) ends with the specified value(s) will be retrieved</td>
<td>text</td>
</tr>
<tr>
<td>Limit Type</td>
<td>Operation Performed to Select Data</td>
<td>Data on which this comparison is valid</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------</td>
</tr>
</tbody>
</table>
| Like       | Similar to contains; this matches the SQL LIKE command and requires that you use wild card characters to specify where arbitrary characters can be inserted; for most SQL databases such as Oracle, the wild card characters are % (any additional characters to the end of the string) and _ (any single character) when entering the specified value. Additional wild card characters may be available and the wild card characters may vary for different databases. In addition, special characters may need to be entered in a specific fashion.  

  e.g. Job_title like ‘T%’
  would retrieve records for jobs like Testing, Typist, Truckdriver, etc.  
  
  e.g. Part_number like “F_ABC%”
  would retrieve items with part number F1ABC999 and FKABCn3646-S. | text |
| Between    | Only data where the requested item(s) is between the specified value(s) will be retrieved. Note that data retrieved can also be equal to the specified beginning and ending values. | numbers, text, dates |
| Is Null    | Only data where the requested item(s) has not been set will be retrieved. Blank strings (i.e. spaces) and zero ARE NOT null values. Only items that have not been set to any value are considered to be null.  
  
  In DSS, no text is set to Null; numbers or dates are set to Null when no value has been collected. For instance SAT score would be Null if the student had not taken the test. | text, numbers, dates |
## Standard Data Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Section Used in:</th>
<th>Operation</th>
<th>SQL Function Generated</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Query</td>
<td>Returns unaggregated values as stored in the database. This is the default in Query.</td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td>All</td>
<td>Calculates the sum of the column in each group (numerical data only)</td>
<td>SUM(column definition)</td>
</tr>
<tr>
<td>Average</td>
<td>All</td>
<td>Calculates the average of the column for each group (numerical data only)</td>
<td>AVERAGE(column definition)</td>
</tr>
<tr>
<td>Non-Null Average</td>
<td>Pivot Chart Report</td>
<td>Returns average of underlying values; null values excluded.</td>
<td></td>
</tr>
<tr>
<td>Minimum</td>
<td>All</td>
<td>Returns the smallest entry in each group (numerical data only). You must set the datatype to include text and dates.</td>
<td>MIN(column definition)</td>
</tr>
<tr>
<td>Maximum</td>
<td>All</td>
<td>Returns the largest entry in each group (numerical data only). You must set the datatype to include text and dates.</td>
<td>MAX(column definition)</td>
</tr>
<tr>
<td>Count</td>
<td>All</td>
<td>Counts the number of appearances in each group of each unique value.</td>
<td>Count(column definition)</td>
</tr>
<tr>
<td>Count Distinct</td>
<td>Query</td>
<td>Same as Count but excludes identical rows</td>
<td>COUNT(column definition)</td>
</tr>
<tr>
<td>Null Count</td>
<td>Pivot Chart Report</td>
<td>Returns number of nulls among underlying values.</td>
<td></td>
</tr>
<tr>
<td>Non-Null Count</td>
<td>Pivot Chart Report</td>
<td>Returns number of underlying values; null values excluded.</td>
<td></td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Query</td>
<td>Returns standard deviation of values.</td>
<td>STDDEV(column definition)</td>
</tr>
<tr>
<td>Variance</td>
<td>Query</td>
<td>Calculates the variance of the selected measure evaluated over the specified dataset.</td>
<td>VARIANCE(column definition)</td>
</tr>
<tr>
<td>Weight</td>
<td>Query</td>
<td>Used to compute weighted values in Pivot reports.</td>
<td>WEIGHT(column definition)</td>
</tr>
<tr>
<td>Rank</td>
<td>Pivot</td>
<td>Returns the rank of a number in a column of numbers.</td>
<td>RANK (numbers, break_col)</td>
</tr>
<tr>
<td>Function</td>
<td>Section Used in:</td>
<td>Operation</td>
<td>SQL Function Generated</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>% of Column</td>
<td>Pivot</td>
<td>Returns sum of all underlying values as a percentage of their respective surface column.</td>
<td></td>
</tr>
<tr>
<td>% of Row</td>
<td>Pivot</td>
<td>Returns sum of underlying values as a percentage of their respective surface row.</td>
<td></td>
</tr>
<tr>
<td>% of Grand</td>
<td>Pivot, Chart</td>
<td>Returns sum of underlying values as a percentage of all surface values in the report.</td>
<td></td>
</tr>
<tr>
<td>Increase</td>
<td>Pivot</td>
<td>Calculates the increase between the previous two rows or columns.</td>
<td></td>
</tr>
<tr>
<td>% Increase</td>
<td>Pivot</td>
<td>Calculates the percentage increase between the previous two rows or columns.</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Report</td>
<td>Returns column names.</td>
<td></td>
</tr>
</tbody>
</table>
## Data Types

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>BrioQuery will automatically determine the data type returned from the database. This is the default and should be the normal choice.</td>
</tr>
<tr>
<td>Byte</td>
<td>A single byte of computer storage. Bytes can take numeric values from 0 to 255 and can also be used to store a single text character.</td>
</tr>
<tr>
<td>Date</td>
<td>Calendar date. This will be stored in the format selected, typically mm/dd/yy.</td>
</tr>
<tr>
<td>Integer (16 bit)</td>
<td>A 16-bit value (2 bytes). A 16-bit integer can take values from 0 to 65,536. If the integer is signed, it can take values ranging from +32,768 to -32,768.</td>
</tr>
<tr>
<td>Integer (32 bit)</td>
<td>A 32-bit value (4 bytes). A 32-bit integer can take values from 0 to 16,777,216. If the integer is signed, it can take values ranging from +8,388,608 to -8,388,608.</td>
</tr>
<tr>
<td>Long Text</td>
<td>Very long text fields. Maximum length is defined by the database and connection API.</td>
</tr>
<tr>
<td>Real</td>
<td>Numbers with decimal points. Up to 5 positions are allowed to the right of the decimal. The range of values depends on the number of decimal points.</td>
</tr>
<tr>
<td>String</td>
<td>Text characters. Maximum length is 256 characters.</td>
</tr>
<tr>
<td>Time</td>
<td>Time. The format used for times is set by user preference.</td>
</tr>
<tr>
<td>TimeStamp</td>
<td>Date/time combination. The format used is set by user preference.</td>
</tr>
</tbody>
</table>
World Wide Web URLs

The following URLs offer assistance when using DSS and BrioQuery.

BrioQuery Tips Page
http://www.adpc.purdue.edu/WAI/Brio/brio_tips.htm

DSS Homepage
http://www.adpc.purdue.edu/WAI/DSS/DSS.htm

WAI Homepage
http://www.adpc.purdue.edu/WAI/